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D=l ES5515H- Standard
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SHH, AP 28 RES 322 WESH L Ats 2E
SIH Y EE HEY 5+ ASLICL

Display: Dell E5515H
Resolution: 1920x1080 Change
(%) auto Mode Configure
) Manual Mode Standard
Erightness; L J 5%

L o
Conkrast: L J 75%
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Dell Display Manager

Dl E5515H

Basic { Auto Mode [ Easy Arrange | Options i ]

Resolution: 1920x1080 Change
(® auto Mode
Use preset mode assignments for active applications

() Manual Mode
Choose a preset mode:

Configure

Brightness: 3 ‘ 5%
Contrast: ‘ 3 ‘ 75%
AMH 2%E ZES S8 =230 X[’8517]
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\ Basic | Auto Mode ( Easy Arrange || Options \ i

Assign a preset mode to a specific application, To add an application, drag it to the list:

Application Preset Mode A~
B2 Adobe Reader 8.0 | Standard he | Remove

’,fé Internet Explorer | Multimedia w |

(X Micrasoft Office Excel | Standard v | L3
[ Micrasoft Office Outlook | Standard v |

(@ Micrasaft Office PowerPaint | Multimedia v |

i Micrasaft Office Word | Skandard v | 3

Use Game mode For fullscreen Direct3D applications

8 ¢ Dell Display Manager A2 X} QFLY A
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| Basic I Auko Made Easy Arrange Options [ ]

Select a predefined or custom window layout For this monitor, Open windows dragged inko each zone wil
position and resize aukamatically:

To create a custom layout, arrange vour windows and then click Save
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Dell ES515H

| Basic Auko Mode Easy Arrange Options i ]

Select a predefined or custom window layout For this monitar, Open windows dragged into each zone will
position and resize automatically:

Easy Arrange @

Your current window layout has been assigned to the custem layout
k button.

To create a custom layout, arrange your windows and then click STVE

M MO Qs AEAF XS 200t S A5t ALE AL X[ F

20|02 OFO| 2 & MENSIYA| . ALE X} K| 2|0[0tR S Mot 2
HHESIHO|A F2 27|t /XS Z|Ch 107H7HX] EA|SE CHZ ZHE F 20

23 XMES SEHMUA L. oX MFE O Y= AHEAL X[F 2|0|0tR S

A
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Dell Display Manager Dell ES515H

| Basic I Auto Mode Easy Arrangs Options 0

H

Select a predefined ar custom windaw lavout Far this manitar, Open windows dragaed into each zone wil
position and resize automatically:

B e =
S o s =
T 1T L1 | (5

To create a custom lavout, arrange wour windows and then click Save
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Dell Display

| Biasic | Auto Made | EasyAmange || Options \ w

PowerNap options:
(®) Reduce brightness when screensaver activates

(O Put the display to sleep when screensaver activates
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B E0f UAELICH ZLHS| EFE = CHE AF0| 2ot E LTt

e E5515H: 1,386.84 mm (54.6 QIX|)9| CHZHA 7FA] O|O|X| 27|,
1920 x 1080 AL, &S O H2 M E Qo FA| slH 2 E X[ &.

. LED #zj0|E
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Dell E5515H

There is no signal coming from your computer. Press any key on the

keyboard or move the mouse to wake it up. If there is no display, press

the monitor button now to select the correct input source on the

On-Screen-Display menu.
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19 &l HDMI {4 E{

19171513119 75 31

18161412108 6 4 2

Pz  [RLE F9|19¢ M= #H0|=

1 TMDS Data2+

2 TMDS Data2 Shield
3 TMDS Data2-

4 TMDS Datal+

5 TMDS Datal Shield
6 TMDS Datal-

7 TMDS DataO+

8 TMDS DataO Shield
9 TMDS DataO-

10 TMDS 2E+

1 TMDS Clock Shield
12 TMDS 2 &-

13 CEC

14 Of| 2FE (FX|2| N.C)
15 SCL
16 SDA

17 DDC/CEC HX|
18 +5V POWER
19 St E8 3 HA
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1 DMU
2 VCC
3 DPU
4 GND

1 2 3 4

HHs  (HYE T 4%
1 vCC
2 DMD
3 DPD
4 GND
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o1 W S840l 715

O ZLIHE= O S210 M E20| =2t AI*E“OHE X2 & ASLIC
SLEE C|AZ2 0| Ho|H ML (DDC) E2EZSS AHESI0] HFH
A0 =Y Cj2~E20] 42 HO|H(EDID)E HSE2 =M A|XHO|
AHHo 2 7ot 2L E1 *a”g = XYt = gtL|C}. CiChe 2L E
dXE As2

Z O|RO{YULCL 272 R CHE S UHE =

ALt

g 74
QEHS Dell E5515H 2 L|E{
&0 o3 S5 0jEA - TFTLCD
g 3& Mz HE
7tAl O[O x|
CHZtM 1,386.8 mm(54.6 21%|)
20 2N oY 1,209.6 mm(47.6 QI%|)
2R B Yo 680.4 mm(26.8 QIX|)
RS 823,011.8 mm?(1,275.7 QI X|)
Id K| (S| Td) 0.21 mm (W) * 0.63 mm(H)
AlOFZt:
BN 178° et
B 178° At
3| =3 350 cd/m?(Ht)
ot | 3000 :1(2gh
HEH g 3H3E Yo 24 YUK 2% SEE
s 2to| E LED 20| E H} A|AE
soar 8ms MBI S| MO0M O &2 Moz HMah
A AT 16708+ e
A O 85 % (LEh*

**[ES5515H] A (U 8H2 CIE 1976(85 %)1t CIE 1931(72%) Al” 7| Z=0f

vES
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ool S Dell E5515H 2 L|Ef
FAL 9]
. 23 30 kHz ~ 83 kHz(X}-5)
. 2x 56 Hz ~ 76 Hz(X}5)
A AP AR SIAE 1920 x 1080(60 Hz Y )

HlC]2 BE X8

oo S Dell E5515H 5 L|E{
H|C|2 C]AZ3|0| 7|5 |480p, 480i, 576p, 576i, 720p, 1080p, 1080i
(HDMI X{44)

H2| 74
DE S Dell E5515H 2 L|E{

Ofet 271 RGB: 0.7V +/- 5%, 752 @2 |

A
C|X| & HDMI: 2t XHE 3| M EH600mV, 100 2 92
olm|HA

S U 2F 57(3 2a) 23 TTLHY,

2-12l(Composite SYNC on green, SOG)

=3 43

100 VAC ~ 240 VAC/50 Hz &&= 60 Hz +/- 3 Hz/2.5 A (

= Z(CH)
EQ NME 120 V: 30 A (%|CH)

240 V: 60 A (%[CH)

24 ¢ RLIEHHHE




AVE 4 C|AZ#0] 22
Ch Ei= Dello] 0[0|X| 27|9 B4 HES BASY| Yo A 4H RES
20| FUc.

cagao e | TE [ 3 | mass | svs3y

Fl(kHz)| Fat(Hz) (MHz) (=4d/5%)
VESA, 720 x 400 315 70.0 28.3 -/+
VESA, 640 x 480 315 60.0 25.2 -/-
VESA, 640 x 480 37.5 75.0 315 -/-
VESA, 800 x 600 37.9 60.3 40.0 +/+
VESA, 800 x 600 46.9 75.0 495 +/+
VESA, 1024 x 768 48.4 60.0 65.0 -/-
VESA, 1024 x 768 60.0 75.0 78.8 +/+
VESA, 1152 x 864 67.5 75.0 108.0 +/+
VESA, 1280 x 1024 64.0 60.0 108.0 +/+
VESA, 1280 x 1024 80.0 75.0 135.0 +/+
VESA, 1600 x 900 555 60.0 97.8 +/-
VESA, 1920 x 1080 67.5 60.0 148.5 +/+

DLEEE o 25



=1 o
OIS #= 2ZHEQ =28 §4= E0FLT
DY S Dell E5515H B L|E|

D-ME OJL, HA A4
HDMI, Z47g A 7{ 4 E

D-ME:
HDMI: Er&FAl CX| &, 19T,

=0| 786.0 mm(30.9 QIX|)
L 1,241.0 mm(48.9 QI%|)
Z0| 245.0 mm(9.4 QI%])

NE=

=0| 721.5 mm(28.4 QI X|)
| 1,241.0 mm(48.9 QIX|)
#O| 64.8 mm(2.6 QI X|)
ARE K|

=0l 154.9 mm(6.1 QI%])
LfH| 530.0 mm(20.9 QI%])
#0l 245.0 mm(9.6 2I%])
Y

EEES S 32.2 kg

AEHE O| 2|2t A0S [24.4 kg

Zool 3

AHE o Ee| 0jZxe B [20.3kg

(HZ0| £& VESA ZO| &

Qlot nAteol 4L -

70l 8i3)

AEBE ojMER| S 3.3kg

26 ¢ HL|E{HH
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23 5y
ChS BE= ZUEHO &E =HS 2 EL|CH
DHHS Dell E5515H 2 L|E]
er
e X 0 °C ~ 40 °C (32 °F ~ 104 °F)
. HEZ H2 -20 °C ~ 60 °C (-4 °F ~ 140 °F)
22 -20°C ~ 60 °C (-4 °F ~ 140 °F)
5=
. =X 20 % ~ 80 %(H|2%)
B2 10 % ~ 90 %(H| 2 =)
° Hl%xl' O A o, o,
= 2210 % ~ 90 %(H|2=)
i
e X 5,000 m (500,000.00 cm) %| 10
« HSE 12,191 m (1,219,100.00 cm) %10
of A} 410 BTU/A|ZH (%] CH)
307 BTU/A|ZH (YBH
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Sz oz HmA[ELCH T
SrL|Ct T/do| A2 A EfO
He| BE Z20f o2f{et 178 T2 27| o0 C|AE 0|2 2t
= AEEE &HAZ|X| EELCH 178 T/d0] 1740l A 571 AtO[ 2l
ClAEY 0l o0 SA0 3 Ues 2E He| Lo ATt 7k
XtM|SH L8 2 Dell X| 2 AIO|EE HHESIMA|
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Input Color Format » RGB
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Dell ES515H

The function of adjusting display setting using PC application will be
disabled.

Do you wish to disable DDC/CI function?

No
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the degree of image retention, the program may take some time to run.
Do you wish to continue?
Reset Other |0| SME MENSIO DDC/CIQF ZE 7|EF 7|2 M E
Settings 2oLt
(Z1Et 2
x7|2h
Factory Reset |= OSD S 3% AMM HEULE X7}t CL
(B Xx7|3H

46 & BLIE|XEB}]




OSD 711 H|A|X]
BRI S8 g =S X -SHA| 2B Chg HAIX| 7L A E LT

Dell E5515H

The current input timing is not supported by the monitor display. Please

change your input timing to 1920x1080, 60Hz or any other monitor

listed timing as per the monitor specifications.
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The function of adjusting display setting using PC application will be
disabled.

Do you wish to disable DDC/CI function?
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Dell E5515H

Entering Power Save Mode.
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Dell E5515H

There is no signal coming from your computer. Press any key on the
keyboard or move the mouse to wake it up. If there is no display, press
the monitor button now to select the correct input source on the
On-Screen-Display menu.
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Dell E5515H

(7) I No VGA Cable

The dispaly will go into Power Save Mode in 5 minutes

www.dell.com/support/monitors
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Dell ES515H

No HDMI Cable

The dispaly will go into Power Save Mode in 5 minutes

www.dell.com/support/monitors
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Dell E5515H

No HDMI Cable

The dispaly will go into Power Save Mode in 5 minutes

o
e

Moy

www.dell.com/support/monitors

Dell E5515H

No VGA Cable

The dispaly will go into Power Save Mode in 5 minutes

www.dell.com/support/monitors
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Windows 10:
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2. Advanced display settings(11 g C|AZ2|0] AH™H)S S|}
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Windows 7, Windows 8/Windows 8.1 EE = Windows 100{| A
T8 RLEHE ddot= EXt
Windows 79| 42
Qe T L|E{E H|C|R #O|E(VGA HDMI §)2 AF310] LEZ0|L}
a3 50| A&t Ch3 orzfel 27 WH & StLIE MEHYA|R.
HHE 1: 2 7}7] 7] "Win+P" A} 317
1. 7|2 0| Windows 21 7| + PE =2 L|c} |

2. Windows 231 7| +& HE{O|M PE =2 C|AZ2{0] & &=
AFOJOf| A gkt L Ct.
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M gE . e

FEH 2: "Screen Resolution” (3} 8| A& %) O 4 A2 38}7]
H

o
1. HIEt 5lHE @ EZ Z2I5} CI2 "Screen resolution” (8}H sfjA )=
S2Lict

=
l Disconnect Projector Duplicate Extend Projector only
L]
H

View »
Sort by ]
Refresh

Paste

Paste shortcut

Graphics Properties...
Graphics Options »
@ NVIDIA Control Panel

Next desktop background

New »
Bl Screen resolution )I
@ Gadgets

B Personalize
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2. Multiple displays (Ct= C|AZ | 0)) E

22st0f C|A B8 0| MeY g2 2
HAIFLC 27l BLIE 7 EAIEX] %8 < Detect (AR

segct

o AAHIO| TS BLIEE LXK 28 H A|AHS XY A|ZHSHO]
1-3CHA S EEg WQIt AUS 4 ASLLCE

Change the appearance of your displays

(@ @

i |

Display: |2. Generic Mon-PnP Moniter = |
Resolution: 1024 x 768
Orientation: Landscape

G!unipuispu:m Bitend these displays v j

AL, You must select Apply before making additional changes.

Make this my main display Advanced settings

Connect to a projector (or press the ] key and tap F)
Maice text and other items larger or smaller

What display settings should | choose?

ok || Comced || Awply |
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Windows 8/Windows 8.19| 2
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HAZE0) Q73S of2fol M Wi F LIS HEYAlQ.
HEH 1: HE2 7}7] 7] "Win+P" AF23}7]
1. 7| 2 £0| Windows 21 7| + P2 =21} (4] |
2. Windows 211 7| £ -2 ME{0|N PE 53] C|AE20| M &=
ALOJOf| A T ZhetL|Ct.

HEEH 2: "Screen Resolution” (8} 8lj At ) M| 57 A}25}7|

1. A|Z} }E0j| A Desktop (HHE} 3HH) Bt S ME4SIO] S 24 Windows
HHE stHo = MatehL|Ch
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2. HIEM 3lHE @ EZ F 2IsH [} "Screen resolution” (3}H Sl AE)E
St
View »
Sort by »
Refresh
Paste

Paste shortcut

New »

!J “Screen resolution
@ Gadgets
& Ppersonalize

3. Multiple displays (C}E C|AE|0])E S &/o10] C|AZ20| ME S-S
BAIG UL Fohel RLE 7L BAIZX| @5 B39 4XIE YL
o AMAERIO| FIHE RLIE S AX|SHX| R Z2 A|IL- S AIHSH
-3 e Bavt U2 4 UsLUL
= Screen Resolution [=la] & |
i/"\.f'\. I . - - -
| L EX3) 4 | « Appesrance and Personalization » Display » Screen Resclution v| e| | Search Control Panel Il | '
Change the appearance of your displays i
Detect
Display: (L DELLUZIIZHM v
Resclution: 1366 =« 768
Orientation: Landscape

(Mun'pledisptm Extend these displays v)

[y You must select Apply before making additional changes.
Make this my main display Advanced settings

Project to a second screen (or press the Windows logo key Sig + F)

Make tet and other items Larger of smaller

What display settings should | choose?

oK Cancel Apply
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Windows 7 EE = Windows 8/Windows 8.10|| A C}Z D L|E{Q] C|AE 0] A
SEIREEL 5
oIF 2L HE 278t = ALEX}= Multiple displays (Ct5 £| 22 0])
Ol 70l M &I5h= CIAEe0] AU S MEdS = USL|CH |20
=H|, CIaEef 0] &%, £ C|AE20|of HHEL 2tH FA|
e Duplicate these displays (C|AZ 0] EX|): Ut 3HS O HE
it o RLIE{O]| 7|255}0f (dENGH S US| 2 &= 2L E O
SHSHH EA|SL|Ct.

Windows 8/Windows 8.12| A%

@u@ 4 [B « Appearance and Personclization » Display » Scrzen Resolution v] & ] [ search Control Panel 2|
Change the appearance of your displays
| Detect |
@ @ . : . .
Display: [zoewuamiaim V|
Resolution: 1366 x 768
Orientation: Landscape
Multiple displays: | Extend these displays v
A, You must select Apply before making additional changes.
Make this my main display Advanced settings
Project to a second screen (of press the Windows logo key S + P)
Make text and other items larger or smaller
What display settings should | choose?
OK || Concel |[ Apply |

66 o DL|E| MdX|5}7|



HEAYLICL O] M2 HEtN o2 LESS PCE ALEY I M

= A2 0| FUS UESHH MEXIL Y 9| F ZLIE S M8 5
UGS LICH CiCh XM S ES2 FR Y =S X[ L|CL 2 D0
ot 4 QI=0|, LEE DL|E{O| AL = 1280 x 800 0|0, 27" Q&
LCD ZL|HE QA3 XS ALK HA ZHIXE 1920 x 1080 & HD
SRR EZ + ASLH

Windows 72| A&

* Show desktop only on (C}S0f| 2t HHE} 5HH BA|): 57 ZLIEO| HEHE
i

Change the appearance of your displays

(@@

Display: [1. Mobile PC Display -]
Resolution: 1024 x 768
Orientation: Landscape -

Multiple displays:

Duplicate these displa
A\ Youmust seled&lf"d these dis|gp 53 pnal changes.
: Show desktop only on 1 .
Make this my migp ., desktop only on 2 Advanced settings

Connect to a projector (or press the B key and tap P)
Make text and other items larger or smaller

What display settings should I choose?

[ ok ][ cance |[ apply |
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Change the appearance of your displays

Display: [1. Mobile PC Display -
Resolution: (1024 <768 ~

Orientation: Landscape v

Multiple displays:

A\ You must select g:ﬂﬁf::f:ﬁ:::ﬂw nal changes

Show
Make this my mJm

Show

desktop on|
Connect to a projector (or press the £ key and tap P)
Make text and other items larger or smaller

What display settings should I choose?

Advanced settings

OK

J[ cancel | [ Appy |

Windows 8/Windows 8.12| A%

@@ = * |i <« Appearance and Personalization » Display » Screen Resolution

vl [+ I I Search Centrol Panel P |
Change the appearance of your displays
| Detet |
@ ® : — |

Display: [2omLU2zIZHM V]

Resolution: 1366= 768 v

Orientation: Landscape v

Multiple displays

Ay You must sel nal changes.
Make this my m

Project to a second screen (or press the Windows logo key 5 + P)
Make text and other items larger or smaller

What display settings should | choose?

Advanced settings

oK

Concel | | Aoply |
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@@ 4 [B « Appearance and Personalization » Display » Scrzen Resolution v[ @] [ search Control Panel 2]

Change the appearance of your displays

Display: (2.DELLUZ3IZHM v
Resolution: 1366768 v
Orientation: Landscape v
Multiple displays: |Show desktop onlyon2 v
|Duplicate these di

A\ You must selec| E)d::\dmﬁe?;:pmw bnal changes.

. = |Show deskt L]

Make this my m Advanced settings

Project to a second screen (or press the Windows logo key Big + P)
Make text and other items larger or smaller

What display settings should | choose?

e e e
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Windows 10 o] Z L

Q& BL|EE H|C|Q # 0| £(VGA, DVI, DP, HDMI 5)2 AI23l0] LEE

= HAIE0 AZs CHS Of2el 7 B J7h2 0| OfF ¢ =

tH& L Ct

HE 1: HE27}7] 7| "Win+P" AF28}7]

1. 7|2 £ 9| Windows 21 7| + P= ==|c}. [4]+[ |

2. Windows 211 7| & £ 2 ME{0AM PE =2 C|A S 0| M =
AtO|Of| A M ztatL|Ct.

<

Project

EAL 1 ecsocenony
ELA owice
o (NN
e H ol
1 HiE olHE 22X 2 2[0t Ct3 Display settings(C| 2 & 2[0] 4%)
2lgtL|ct

% AMD Catalyst Control Center

View T
Sort by >
Fefresh

Paste

Paste shortcut
Undo Rename Ctrl+Z

MNew s

1 Display settings
& Personalize
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2. Customize your display (C| A Z8|0| AF2 X} X|H) 2510 C|A S| 0|
ME 2 F2 BAZUCHL F7HE BLEHZ HARX| &2 82 4XE
Szt

+ N2gol 27tel BUEIE AXSHR] R B2 AL KA B0
1-2 B gt madt g + YaLch
€& Seftings = m] X
@ SYSTEM | Find a setting P
Display :

Customize your display

Notifications & actions

Apps & features

Multitasking 1
Tablet mode

Power & sleep
Identify  Detect

Storage } .
Change the size of text, apps, and other items: 100% (Recommended)
[
Offline maps | J
Orientation
Default apps
| Landscape ~ |
About
Multiple displays
| Extend these displays v |

D Make this my main display
Apply Cance

Advanced display settings
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QF RLIHE 28 = MAEA= OF B[220 B 70N CHS
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2td, 58 CIAZ20]0] BHEf 23 HA|.

o CIAEY 0]l SH: U o}HS O K2 oo ZLIHO| 7[2=510]
HEiD SUS S =2 & 2L O ZH|5H0] AR L CL

Windows 8/Windows 8.1°2| A2

< Settings = o X
3% sYsTEM [ Find a setting o
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